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1. LibreOffice Writer

Introduction, Objectives, Word Processing Basics, Opening word Processing,
Title Bar, Menu Bar, Toolbars & Sidebar, Creating a New Document, Opening
and Closing Documents, Opening Documents, Save and Save As, Closing
Document, Using The Help, Page Setup, Page Layout, Borders, Watermark,
Print Preview, Printing of Documents, PDF file and Saving a Document as PDF
file, Text Creation and manipulation, Document Creation, Editing Text, Text
Selection, Cut, Copy and Paste, Font, Color, Style and Size selection, Alignment
of Text, Undo & Redo, AutoCorrect, Spelling & Grammar, Find and Replace,
Formatting the Text, Paragraph Indentation, Bullets and Numbering, Change
case, Header & Footer, Table Manipulation, Insert & Draw Table, Changing cell
width and height, Alignment of Text in cell, Delete / Insertion of Row, Column
and Merging & Splitting of Cells, Border and Shading, Mail Merge, Shortcut
Keys, Summary, Model Question and Answers.

2. LibreOffice Calc

Introduction, Objectives, Elements of Spread Sheet, Creating of Spread Sheet,
Concept of Cell Address [Row and Column] and selecting a Cell, Entering Data
[text, number, date] in Cells, Page Setup, Printing of Sheet, Saving
Spreadsheet, Opening and Closing, Manipulation of Cells & Sheet, Modifying /
Editing Cell Content , Formatting Cell (Font, Alignment, Style ), Cut, Copy,
Paste & Paste Special, Changing Cell Height and Width, Inserting and Deleting
Rows, Column, AutoFill, Sorting & Filtering, Freezing panes, Formulas,
Functions and Charts, Using Formulas for Numbers (Addition, Subtraction,
Multiplication & Division), AutoSum, Functions (Sum, Count, MAX, MIN,
AVERAGE),Sort, Filter, Charts (Bar, Column, Pie, Line), Summary, Model
Question and Answers.



3. LibreOffice Impress

Introduction, Objectives, Creation of Presentation, Creating a Presentation Using a
Template, Creating a Blank Presentation, Inserting & Editing Text on Slides, Inserting and
Deleting Slides in a Presentation, Saving a Presentation, Manipulating Slides, Inserting
Table, Adding ClipArt Pictures, Inserting Other Objects, Resizing and Scaling an Object,
Creating & using Master Slide, Presentation of Slides, Choosing a Set Up for Presentation,
Running a Slide Show, Transition and Slide Timings, Automating a Slide Show, Providing
Aesthetics to Slides & Printing, Enhancing Text Presentation, Working with Color and
Line Style, Adding Movie and Sound, Adding Headers, Footers and Notes, Printing Slides
and Handouts, Summary, Model Question and Answers.
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Introduction to LibreOffice

LibreOffice T& Open Source Software gl Ig& Microsoft Office Fr atg & v Office Suite
g LibreOffice @I saer Official Website www.LibreOffice.org & Free download f&ar s
Tt gl Libre Office & Microsoft Word @&r g Word

Processing & fow Libreoffice Writer f&ar rar § st aR® ‘
Microsoft Excel & ¥TueT WX Libreoffice calc 3R

PowerPoint & TaT WX Libreoffice Impress, aur

Microsoft access & ¥4isT 9 Libreoffice base f¢ar arar Libre Office

gl Libreoffice ©w& Open Source 3R Application The Document Foundation

Software & l '
History of LibreOffice - fora3iifrd &1 sfagm

Libreoffice I & siog#ic Br3sUT gaRT fahfAd fhar a1 § 3@ Tgell IR25 Sefadl 2011
o fhar rar or Libreoffice & Programming C++, Java, 3R Paython Programming

Languages ® &I a5 § I§ fSoshel faes 3 Open Source Software gl

Components of LibreOffice-

1. LibreOffice Writer =m| |===

2. LibreOffice Calc = 1A |

3. LibreOffice Impress — "__‘

4. LibreOffice Base D

5. LibreOffice Draw = VX ‘ =» |

6. LibreOffice Math
LibreOffice # 3-Application Main gt 2-

» LibreOffice Writer- IIg Microsoft Word & T &R¥ & gl
> LibreOffice Calc- I& Microsoft Excel & T#ATT FT T &
» LibreOffice Impress- Ig Microsoft PowerPoint & HHT HRT T ¥l

Introduction to LibreOffice Writer

LibreOffice Writer w& Word Processing g1 Word Processing @& Application Software
giar &, St User @& Text Type &el, Edit &% dur Manipulate & & giaer &ar g



Word Processing Software @r 393ier Latter, Report, News Latter, Table, Form &= &
T fhar SITar § 39 UToliheld WA HI 3UINET & 3T 39«7 Document # Picture 3R
Chart sff Insert =X TFa & 3R 5TF Text ¥ JAIff=T o & Formatting & $r S &
g&eh ST AET &9 & Office & fohar Sirar B

Word Processing i mfaf@a fveram -

» Type T 71T Text & RN & Scora fhaT ST Tohal B
» Document & spelling & arafaal & & Far a1 devar Bl
» Word 31t Sentence & &erar & Add, Remove 31X Replace far ST &@ar 2l

» Word Processing Software # Mail-Merge e 39aieft Tool &, St 3w List, Database,
3iR Spreadsheet # Store JTHRT &I 39T aX Multiple Letters, Labels, Envelopes,
Name Tags 3¢ sarel T gt &ar Bl

Opening LibreOffice Writer

Method 1:- Click on Start Button—>Select LibreOffice 7.6—> LibreOffice Writer.

Method 2:- Double Click on LibreOffice shortcut frome Desktop—>The Select Writer
Document.

Create:

24| Base Database

[ LibreOffice

Extensions

Method 3:- Write swriter in Run Dialog Box (Press Window + R Key Then Run Dialog
Box Will be Open & Click on ok Button.



Type the name of a program, folder, docurnent, or Internet
resource, and Windows will open it for you.

= f|

—=

Open: SWriter

QK Cancel Browse...
LibreOffice Writer Window
& S & =
File Edit Miew Ifsert Format Styles Table Form  Tools |Nindow Help @ X
B-5- L& @ Bl B AT H-HihE=EE-Q- 2000 LB NO-2
‘DefaultParagraphSty\ \/|r/24,” /}5;” |L\berationSerif V| ‘12pt V‘ B I u - 5 X5 X, AA‘P A- 2 EE E EE E ‘EE - :EE - l'?: - _E E $§ - i$
L g i F E K K PN, Al =
\ 4
| Title B . z
1T1l€ bar
Menu Bar * g
Standard toolbars ] [ Sidebar — -
A 4 \ 4 ﬁ@j}‘
Ruler [ Formatting toolbars ] ‘D»
E

Page 10of 1

0 words, 0 characters

[ Status Bar ]

Default Page Style

English (USA) ]

[ Zoom Side Bar

BOO N ————a——+ 100%

1. Title Bar- Title Bar Window & @s® 3R &fast 92t gt § 59 ® oA & fvew
(ersed) fe@mar arar & 3R Title Bar & Right Side & s Control Button gid g1 foa®
T minimize, maximize 3R close gar g1 Default WM &1 ¥ untitled 1 81T &1

2. Menu Bar- g @@ecd R & 8& g gar & 39 9 File, Edit, View, Insert Format,
Styles, Table, Form, Tools, Window 31X Help &1 & Total 11 #=g gld ¢ ol W

fForh P g1 s W & 3T Fea g



3. Standard Toolbar- I8 Menu bar & 8% & glar & 99 W #8 R & Tools e
g 38- Save, Open, Print 3mfg|

4. Formatting Toolbar- Ig Standard Toolbar & && = gar § 3@ W Text &r
Formatting a1 & ot &5 T@g & 32« glad & =¥ Font, Font size, Bold, ltalic,
Underline, alighment 3mfe]|

5. Ruler- Ruler @r Computerize Scale 8 &gd & ¥ horizontal 3 vertical g &R &1
gl 81 3O Usr &Y Afa 3R AT Aehe set $r S &1 8@ hide 31 unhide &
&r eiiche Ctrl + Shift + R8T &

6. Status Bar- ¥g @«@ Iy #r Horizontal gedt gl § {59 & File &7 Status 2@ Tehd
g Y BIed & FiT O1 U1 FFR &, Fda 99, fohder 376TX 3R fhder ereg g2m i O e
e § MM q@ Fehdl g Y & dT W gl 3R Siagic oF de AR AT Tof §iar Bl

7. Zoom Slider- Ig Status Bar & Right hand side & &d g/ar &1 97 $r Size &' "=
g dold o fov s@er 39ier far Srar g1 LibreOffice Writer & Minimum 20% @2
Maximum 600% & Zoom fRaT ST dehaT

Creating a New Document

LibreOffice Writer # New Document Open &« & folT &g aliehl & 39T foham ST g

Method 1 —Menu Bar 9¥ File>New->Text Document T 39319T &t New Document
Open & Fahd &l

Method 2 — New Document Open @<= & faw Ctrl+N Shortcut &T 39aieT T Iha |

Method 3 — New Document Open &« & faw Standard Toolbar W new icon W
Text Document W click #& Open & Fad gl

&

File Edit View |Insert Format Styles Table Form Tools Window Help

[y ] il 1] i — [
Bl{=-E- 0 &2 il L% T IE-ih B =
Default Paragraph Style o %}7 ;g;’ Liberation Serif ~| [12pt |~ B I u v 5 X2 ) 0} Lﬂ‘;. i

7 i 7 3 4

L £ 3 =
& L & L L L L L L L L

Note - 3 Option T Practial Upciss Prime YouTube Channel & &I1&T AT g1

£

w



Opening and Closing Documents

Opening Documents

File Opening @ oXg & & Fahell § Us s BIsd ¢ AR gaU Fig & IRadsr aa & fow gger
4 Al Brsc| dfchel fohell ot BT 1 9 w § Ggo ARG Y 6 g8 Save fohar ST
IhT & T e

RAFfAfRT TT FT TANT FT Tga & aeif BIS5d F 39T T dTFad &

Method 1 -Menu Bar ®X File » Open d@rer 3R wsel &f Salect aX 5 3 wrser &1
Open T &l

Method 2 — ugar & =1 File Open &t & faw Ctrl + O Shortcut & 39AWET T b &l

Method 3 — ggor & &=t File Open &t & faw Standard Toolbar 9T Openicon W@
click Y 3R e & Salect | 5 F & wSer @ Open FET &

=

File Edit View Insert Format Styles Table Form  Tools Window Help

Blotd- D& 2 Bl & A% T 1E L

|De‘FauItF'aragraphSt_t,rIe V‘r[g;‘ /Q;’ |Liberaticrn Serif V‘ ‘12pt V‘ B I U-5§ X2 X,

L 7 1 : i 4
é L L L L L

Save and Save As

Writer & felt st wiger o A9 A & v af alis Rw gid & Save 3R Save As s g=t
AheT FT 39T T FET 9 BISeT & Save FX Tohd g oAlhed o1 Gl Tdshed & ATST 4T
e} gl &

Save - St sferge 39 Type fHar § 38 Save & & AU Save &wATS &1 39ANT fHar Sram

¢ Save HATS T TG T 3T ISl HI ATH IR 3T BISel HI fhd Location I I § safoIw
Save HATS H 3UAT fHAT ST §

File T save &t & foT File Menu & St Save Button W Fee &Y ar 5T Ctrl + S
FT YA HL



Save As - Save &I a1t File & %o dRade #t& 38 feedr 3R @A, Format @ar Location
9 Save FA & folT HHT 39T fhar ATar g1 Save As &t & forw Ctrl+Shift+S eéshe
$T JAT A gl

Closing Document

v’ LibreOffice Writer & Open Document & & & & faw File & SR Close f@eq
T 39T HL|

v’ 71 5T Menu Bar & Right Side & X Button & 392 &Y|

v’ Ctrl + W 2iiéhe T 39T Y|

Closing LibreOffice

v g @l @ LibreOffice #' Close &' & faw File Menu # s Exit LibreOffice, ™
Click &3]

v Ctrl + Q AiEhe &1 39T A

v 71 R Title Bar & Right Side & Close(X) Button & 3uzer &Y

Using the Help

LibreOffice Writer & 3@R &5 Online Help o= & ar 3@ foT HEE eicehe F1 ar iR
File Menu & SR Help T 393191 &Y

Page Setup

gor &r dfcer S- Page Size, Orientation, header and footer etc. & @C #a & U
PageSetup Option 393ier fHar ram &1

Page Setup &I & Format = Page Style->Page Option &T 3UaYr &I|

LibreOffice Writer # Page Orientation & 9&R & gId g Portrait 3R Landscape default
& & Page &r Orientation Portrait T g1



=]
Organizer Page Area Transparency Header Footer Borders Columns Footnote
Paper Format
Format: |LE1:ter w |
Height: 11.00° =
Orientation:  ®) Portrait
O Landscape Paper tray: |[FrDm printer settings] |~ |
Margins Layout Settings
Left: 0.79" z Page layout: [Right and left v|
Right: Page numbers: |'I_. 2.3 .. w |
Top: 0.9 = [ Use page line-spacing
Bottom: Reference Style | |
Gutter: Gutter position: |LE‘H: w |
[ Gutter on right side of page
Background covers margins
Help Reset Apply oK Cancel

Print Preview

Print Preview & gaRT Type f&U 3¢ Document &l &= & folt &Xa § o 3maer Document
Print aal WX fpg adies & fe@rs ¢am|

v’ Print Preview @ % fa¢ File Menu # S Print Preview Option W e Yl
v’ Ctrl + Shift + O 2licehe &1 3TN H|

Printing of Documents

v’ Document Print &= & faT File Menu # ST Print Option W e &¥
v’ Ctrl + P 2iféshe T 39T Y|

PDF file and Saving a Document as PDF file

Copyright © 2024 UPCISS PRIME



v/ game a1 Document & PDF(Portable Document Format) wife & Save aer & faw
3 File Menu & Export @ f&Fas |

v’ t& new window R@$ & 3@ new window ¥ location & TgeT &Y, gf 3mq pdf
I Save HAT IEd gl

v/ 2as wigel &1 A 31 a2 Save As Type & Sl &1 wife .PDF T

=] [== |
M E » ThisPC » Documents v 0 Search Documents 0
Organize + Mew folder == - 9
I This PC ad Mame Date modified Type
i 3D Objects Camtacsia T/3/2024 10:04 PM File folder
I Desktop Corel 1/13/2024 1:03 PM File folder
B Documents Custom Office Templates 372772024 8:57 PM File folder
FeedbackHub 12/24/2043 212 PM File folder
; Downloads _ )
My Data Sources 2/25/2024 8:13 PM File folder
$ Music My Palettes 6/1/2024 11:44 PM File folder
&= Pictures
ﬂ Videos
e Local Disk (T o« >
File name: | Untitled 1.pdf | -
Save ast_',rpe:l PDF - Portable Docurnent Format (%, pdf) I ~

Automatic file name
extensicn

[] Selection

» Hide Folders Save Cancel

Text Creation and manipulation

LibreOffice Writer & text @I for@r va Manipulated fFam ST @&hdr § S8 ¢Fec Fl Tolae
HAT, TfSe FET, Fe Pl IFC FLEAT, Biee U Blee A5 Solell AT

Document Creation

forst 3Hifhe WX A 7T Sageie a1 & fav &8 Ao fov g &

v T sTcrq‘\afic g7 & fow File>New=>Text Document ST &l I Y
v' Ctrl + N 2li¢ahe T 3UAT H|

Editing Text



LibreOffice Writer Document, & &Y T W 3PR IS Sl T & dl Scolld Hlad &
forT Mouse & TgrIdT @ fFersh Y AT AfINMT Fofl T 3TAT A 3R AT AT ofl & 916
Delete key ar Backspace & 34 ara &t Delete 31K f@er g&d § 31K 38% T« W New
Word for@ @ g

Text Selection

s 3P E TseX F Caee F Aodde FA F g AR fashed &1 &

v" Shift + Right Arrow — S0 & g0 X Tolde F|
v’ Shift + Left Arrow - gIT ¥ I & Helae Y|
v Shift + Up Arrow - sl & 3R a8 Jolde H|

v’ Shift + Down Arrow — 30T & HI 8T Jolee |
v" Double Click on Word- 2rsg &I fioiae &Y |

v’ Triple click on a Sentence- I/ #I Jddc F|

Cut, Copy and Paste

B untitled 1 — LibreOffi

File Edit Wiew Insert Forat Styles

E-E- -0 e

ble £ Tocls Window Help

B~ & S q B3 -

B’|

Cut - Selected Text &I THh TUT H g G TUH W o S fow Cut Option  3uier
[ERINCIGINS

v Cut #tr & fav Edit>Cut & =aeT &t
v’ Ctrl + X 2i&he T 3T HY|

Copy- Selected Text &T Duplicate Copy &+l & folw Copy Option &T 393191 fohar STar
gl

v Copy &= % v Edit>Copy 1 7o Y
v’ Ctrl +C 2liéahe &1 39T A

Paste- Cut ar Copy f&ar 1T Text @I Cursor & TI W (W@ & ToIT sHST 39T Thar
ST gl

v Paste #%r & faT Edit>Paste &7 T &t
2



v’ Ctrl +V 2i&ahe &1 393191 |
Font, Color, Style and Size selection

37 @3t Option &1 3939T Document & Format e & T fohar Smar § 31k 3 Option
Formatting Toolbar & feu g &1

% Untitled 1 — LibreOffice Writer
File Edit Wiew Insert Format Styles Table Form  Tools Window Help

B-H-H-0& 2 Bl & LAY B-WDhERBE-0O-
Default Paragraph Style V|'f¢!§’ ,%5’ Liberation Serf et |12pt | B | Q - 5 x? Xz f“; & v 2 - EE
L &7 i 3 E 4 :

l l /\‘ | I 1 I I | | | | 1

Style Font Size Color

v LibreOffice # wfee Font Liberation Serif gwT &

v LibreOffice # Formatting toolbar & Color e @ 39aiT &% Text r Color
ST HehaTl &1

v LibreOffice # Minimum Font Size 2 3¥ maximum font size 999.99 gxar &I

v LibreOffice # Style Req & grards & font style Il Fhd &

Bold, Italic and underline

Bold {Ctrl + B}:- Selected Text &I HieT a=t & AT sHHT IUAT FAT AT &l
Italic {Ctrl + 1}:- Selected Text &I foR©T a1 & T sHSHT 3UAT FAT AT gl
Underline {Ctrl + U}:- Select & a1T Text & & T a8 Tael & T |

Superscript {Ctrl + Shift + P}:- Select & 1T Text & SHABA & FW (T & & #H)
X & AT sHET 3UART FAT o &1 - (A+B) 2= A2+b%+2ab

Subscript {Ctrl + Shift + B}:- Tclgc f&d 1T cCaee oI SHASA & oild el o TolT ST
39T R SraT &1 - CHi1206 = Glucose
Alignment of Text

LibreOffice Writer # Tl &t Text &I Left, Right, Center 37 justify &= & faw ax
Alignment gld § ¥ IR Alignment Formatting Tool Bar # ga gl



AT EH-WhE=E-Q- 8180
B Iu"'S’ x}. x‘;_ _p ﬁvé‘-’)v

v’ Left Alignment — Ctrl + L
¥v" Right Alignment — Ctrl + R
v Center Alignment — Ctrl + E
v’ Justify Alignment — Ctrl + )
Undo & Redo
Undo - Undo Option 3931eT Step by Step @& et & fow fFar Srar gl
v’ Undo #=a & fat Edit->Undo &1 =g #Y
v’ Ctrl + Z eiiche &1 39T |
Redo- Redo Option s&eT 393191 Step by Step 3T Siet & forw fham ST gl
v’ Redo &%= ¥ fw Edit> Redo & @aet &Y
v Ctrl + Y 2iicahe F 39197 HL|

AutoCorrect, Spelling & Grammar

AUTO CORRECT- Auto Correct fahed &= ersfier Jieal & gurdr g1 Example 3R

S T A hte for@ far § ar 5@ & the & sgor goml Ifg 39 =g ar Auto Correct

Option & §¢ 81 X Thd & ¢ A & foe- Tools Menu—> Auto Correct>While Typing
Aa  AutoCorrect ’ - ~  While Typing

AutoText... Cirl+F3 Apply
Apply and Edit Changes

Redact AutoCorrect Options...
Spelling & Grammar (F7) - s a1v sfeg#ic # Spelling and Grammar @I Check
T dUT 3og O Hlad & [T STPT 3YAT fHar Srar &

Find and Replace



Find & garr #I$ ¢aee gaT ofidr § 3R Replace & g@anT 3d THEE & T W Hlg GO
carre for@r amar § 3R Replace All & a8 ¢aee e aR H & 99 918 & SIar gl oiar &
39 Image H @ Thd g-

23

Find: | v|
[ Match case  [] Whole words only

Replace: | &S |

= Other options
o t selection o ] Replace backwards
O Comments O Paragraph Styles

[ Regular expressions
[ similarity search

Diacritic-sensitive

Attributes... Format...

Help Close

v’ Find Dialog Box Open e & frw Ctrl + F eiféahe & &7 w=ier Ream e &
v’ Find And Replace Dialog Box Open e & frw Ctrl +H efése $r 1 w2 fRam sar

gl
Paragraph Indentation
e 1 AT FF & faw Paragraph Indenting 393y fFam s 21

gseeel WETh T gl AT a0 AT W A @ FURT e g1 Aol & 3ieT 319 R &
Teh THE AT THE & ISCUT 1 ¢ AT Tl Hehdl &1 3T Ueh Adlfed $5¢ &l Hehd & St RIEH
&I 90 AfST dr 3R Giadr § AT U gt g5¢ & off frve o ahd § foad Rmamw &
goll UTFd 85 Tl Sl STl olfdhe] &G Pl S SS€ T STdl &l

v e S8 s ¥ v Format->Paragraph-Indents
v’ Ruler & @ RmEme #r 58

Bullet and Numbering

v/ Bullets 3k .Nu.mbering & fov Format.ting Toolbar & [IE*“ % m E?F
Bullets am #eRer Numbering ™ &l &1

1=
- = -

-



v’ Shortcut Key Bullets & farw Shift + F12 31k sisx Rew & faw F12 &1 39391 &3
Change Case

Change Case & garT Alphabet Character @ Capital arSmall Letter # ScolT I Hehl
g 3P TSeX & s YR & »T T 39A9T fFar Srar & s i Selected Text i
UPPERCASE, lowercase, Cycle Case, tOGGLE cASE 3R Sentence case # 9Rafdd &=
$r giaer Ior ¥ 3

Format Menu—>Text>Uppercase/Lowercase/Sentence Case

Format = Styles Table Form  Tools Window Help
A Text + B Bold Ctrl+B
1= spacing vl halic Ctrl+|
= Align Text v | U Ssingle Underline
JL Clone Formatting U Double Underline  Cirl+D
A Clear Direct Formatting Ctrl+M i’ Strikethrough
Spotlight Character Direct Formatting O Oyerline
B Character.. X*  Superscript  Ctrl+5hift+P
% Paragraph... ¥z Subscript Ctrl+Shift+E
= Lists v | § Shadow
% Bullets and Numbering... HQ_ Qutline Font Effect
Theme... ;{T Increase Size Ctrl+]
[& PageStyle.. Alt+Shift=P | A" Decrease Size Cirl+[
B TitePage.. Al UPPERCASE
Comments al‘_Ji lowercase
Caolumns... Cycle Case Shift+F3
Lo Sentence case
szEfars Capitalize Every Word
el Image 4 tOGGLE cASE
[ T . )

Header & Footer

Header and Footer Insert &% & o Header, Footer Option 393191 fhaT STCT B

Alc:- Header Page & 39X Top Margin # Si&fé Footer Page & &9 Bottom Margin
H @mAT AT gl

D Header and Footer b EI Header b
Envelope... D Footer ,
w

Signature Line.., Use header/footer menu




Table Manipulation

LibreOffice Writer # Table s #gcaquT Option & fo/@er 39aer Document # te Table
@I Draw &% 31X Insert &%l & T fhar Srar § T Table & Row 3R Columns @t
St Table &! S=rT STl &

Insert and Draw Table

v Table insert = ¥ T Table Menu W STa Insert Table 99 &¥|
v' Ctrl + F12 2li¢ahe ST 3T |

v/ f57 Table Dialog Box f@@r$ &m =& Dialog Box # 379el 3maeashan 38R Row 3R
Column &r =T Enter Y ST 3T d8d & 3R §TC §cad W [Folh HL

o

General

Name: Tablel

Columns: |2 = Rows: |2 =

Options
[ Heading
Repeat heading rows on new pages
Heading rows -
[] Don't split table over pages
Styles

Default Table Style Jan Feb Mar Sum

Academic Not 6 7 8 2
Box List Blue

Bow List Green
Box List Red Sout 16 17 18 51

Mid 11 12 13 36

Box List Yellow Sum i3 36 3L 108
Elegant W

Help Insert Cancel




Changing Cell Width and Height

Table & Row 3R Column & Height 3R Width e & foT g7 37 Option &1 use
B

Table Menu—>Size>Row Height/Column width &1 3935eT 1|

Alignment of Text in cell

Table # Text @I TaEadHec a1 & folv Formatting Bar &1 39ier fohar arar & o
TETIdT & §H <o & e &l Left, Right 3R Center & T&hd §|

Delete / Insertion of Row, Column and Merging & Splitting of Cells

39 3911 3TERIHAT & TR Table & Row 3R Column &I Insert 3R Delete &Y dhd
gl 3R 39H dcad FT ahd gl

Table Menu—>Delete>Rows/Column/Table

Marging Row, Column and Cell

39 Row o 3R Cell #rSelect &Y & 3T #AST =T a8 ¢

Table Menu—>Merge Cells

Border and Shading

39 Table, Paragraph @I Select ¢ f5@a W 39 s Border @ @1 dgd &1

Border @emet & folw Formate Menu X ST 3R Paragraph &' Select & t& Paragraph
dialog box &hIeT oX few@rs 23m Border Type WX Click &Y fhT 39 370el 3TaRTehll 3TER
Line Style, Width, Color, Padding, Shadow Select & T@Fd & 3R 39% a1 ok WX Click
|

m
a

Indents & Spacing Alignment Text Flow Outline & List Tabs Drop Cjps Borders firea Transparency

Line Arrangement Padding

Presets: [ Left:

User-defined: Right:
LS
Eotom:
i\{nchromze

Line Shadow Style

Style: Position: E Oo|0o|o|a

Color: | Black C Gra

Width: [Hairline (0.05pt) |~ Distance: |0.07

Properties
Merge with next paragraph

co



Define Border for Page
U7 7 SIS PN & T 3 Ahedl T 3TN I Toho &

v’ Format Menu # Se Page Style Option #r Select #Y|
v’ Page Style dialog box & Border option @ Select &Y 3ik 3r9= 37ER border @

apply &I
L&
Organizer Page Area Transparency Header Foote Border; Columns Footnote
Line Arrangement Padding
Presets: ol Left:
User-defined: Right:
b1 Synchronize
Line Shadow Style
Style: | A Position: |4 O || OO | E
Color: | Black 5 Color Gray
Width: |Hair|ine£{l.{]5pt]| ~|  Distan ce 7 :
Help Reset Apply oK Cancel

Mail Merge

AT FASl Teh VAT 3YOT § o1 eh SaRT Ueh H1Y $3 olldll i cAfFadlad sHel o1 9 fer@n o
GhdT g1 T8 gheflic S 31 Hidl & 3T AT Hdl ¢ 3R U # Colagiesd Hl e cTiad
& T grefiies SRl & Y dGolel & foU ST IUANT T §| AT ol JIALT FH HAat Hles
& & F Y T ST

AT A & AH




AT AN F F§ B 81 T W 5 GG AT GGy g:-
vV Ao FST QR @ U & OF F aE T F A B ST A @ S ¥ Th 9’ A B
AT @l AT ST Hehell 8, TIEQ &F 3¢ RN & 99 A1 F6hd ¢l

V I A F 3T A, g UAF UF F TS odddT H A T § ST AL e
EECURY

V' & ae HTT TS F qHATEIT AT g

v 75 T ¥ iR @ S aud T §1 58 dgd A T o T e = ifE T
TR & &% 97 o o Fha B

V' O Y G AT T ¥ iR AT 9T & AT a7 uh o IRade 3 @l aredeheiai
& T & gRaf@a geml
AT Ao F AT Afaf@d RQEeal &1 3TANT ST g ar &

Tools = Mail Merge Wizard &7 T3 |

Select Starting Document for the Mail Merge
Steps
(®) Use the current document

1. Select Starting Document Exchange Databases...

2. Select Document Type () Create a new document

3. Insert Address Black (O Start from existing document

Browse...
(O Start from a template

Browse...

Help < Back Mext = Finish Cancel
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Mail Merge Wizard # 9= =Rolt & @1 |

v’ Select Starting Document: IdATT SFgHAC W A A GRH H & fAU gud7 R@sweq &t
|

v’ Select Document Type: Letter a1 E-Mail Message fd&heq &I T=i|

v" Insert Address Book: Select Address List =X Click &7

=]

Insert Address Block

Steps
1. Select the address list containing the address data .
- - Select Address List...
) you want to use. This data is needed to create the =
1. Select Starting Document address block
2. Select Document Type . .
This document shall contain an address block
me
More...

olumn Match Fields...

4. Check if the address data mat

ocument: 1

Help < Back Next > Finish Cancel

v’ Select Address List dialog box: Create Option @¥ Click |

Select Address List @

Select an address list. Click "Add..." to select recipients from a different list. If you
do not have an address list you can create one by clicking 'Create...".

Your recipients are currently selected from:

Mame Table Add...

Remove

Create...

Filter...
Edit...

Change Table...

Help oK Cancel

11



v New Address List: Dialog Box & u¥ Urcq &=t arel et &t & Address &r gof
#{ AR List @ OK ) Fae &+ save H|

few )
Address Information New
. Ll —
Title | |
Delete
First Mame | |
Last Mame | | i
Company Mame | | Customize...
Address Line 1 | |
Address Line 2 | |
City | |
State | | v
Show entry number < < = =
Help oK Cancel

v/ Save #r 71§ Address List @ Select Address List Dialog Box # Tl 3IROK =
Click &I

vail Merge Wizard 23
Insert Address Block
1. Select the address I|lstcont§|n|ng the address data Select Different Address List...
i you want to use. This data is needed to create the —
1. Select Starting Document ackdness blodk
2. Select Document Type Current address list: asd
3. Insert Address Block 2 This document shall contain an address block
4. Create Salutation <Title> <Title
5. Adjust Layout <First Name> <Last Name> | <First Name> <Last Name>
<Address Line 1> <Address Line 1>
<ZIP» <City> <ZIP> <City>
<Country> More...
Suppress lines with just empty fields
3. Match the field ed in th il to the col
atch the field name used in the mail merge to the column Match Fields...

headers in your data source,

4. Check if the address data matches correctly.

Document: 1 || |+

Help < Back Next = Finish Cancel
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v 3 Rw 71w Picture & 38R Insert Address Dialog Box # Next Option @
Click &I

v/ Create Solution: =& =RUT & &9 1 Aoy ST arer g7 & Name 31X Address fra
RE & fogar S 39 99T |

=]
st Create a Salutation
oteps
This document should contain a salutation
1. Select Starting Document Insert personalized salutation
2. Select Document Type Female |Dear Mrs. <Last Mame>, ~ | New...
3. Insert Address Block
Male |Dear Mr. <Last Name>, ~ | Mew...
4. Create Salutation - =
5. Adjust Layout Address list field indicating a female recipient
Field name |Gender w |
Field value | e |
General salutation
To whom it may concern, | ¥
Preview
Dear Mr., Match fields...
Document: 1 |+ |+
Help < Back Finish Cancel

Adjust Layout: Address Block 3 Salutation & Layout @I §#aRIGT & 3R
Finish Option @ Click #I|

=
Adjust Layout of Address Block and Salutation
Steps
Address Block Position
1. Select Starting Document From top 217 o
2. Select Document Type Align to text body
3. Insert Address Block From left |0.08 =
4. Create Salutation Salutation Position _
<Firs: Nams= <Las: Names-
Move v e
Move Down
Tawham it may cancarm,
Help < Back Next > Finish Cancel

Print Option &T 39T X Mail Merge Document &I Print &{|
13



Shortcut Keys Effect

Shortcut Keys for LibreOffice Writer

1. Ctrl+N New

2. Ctrl+A Select All

3. Ctrl+L Align Left

4, Ctrl+R Align Right

5. Ctrl+) Justify

6. Ctrl+D Double Underline

7. Ctrl+E Center Align

8. Ctrl+H Find & Replace

9. Ctrl+Shift+P Superscript

10. Ctrl+Shift+B Subscript

11. Ctrl+S Save

12. Ctrl+Shift+S Save as

13. Ctrl+Z Undo

14. Ctrl+Y Redo

15. Ctrl+1, Ctrl+2.... Etc Heading Style

16. Ctrl+Enter Page Break

17. Ctrl+Left Arrow Go to beginning of word
18. Home Go to beginning of Line
19. End Go to End of Line

20. Ctrl+Home Go to Start of Document
21. Ctrl+End Go to End of Document

14




22. Ctrl+Backspace Delete whole word
23. F2 Formula Bar

24, F3 Complete Auto text
25. F7 Check Spelling

26. Ctrl+F7 Thesaurus

28. Shift+F11 Create Style

29. F12 Insert Number

30. Ctrl+F12 Insert Table

31. Shift+F12 Insert Bullets

32. Ctrl+P Print Document

33. Ctrl+Shift+O Print Preview

34, Ctrl+W Close Writer

35. Ctrl+Q Close LibreOffice
36. Ctrl+Shift+V Paste Special

37. Ctrl+Shift+C Track Change Record
38. Ctrl+Shift+R Rulers On/Off

39. Ctrl+F5 Sidebar (Show/Hide)
40. F11 Show Style

41. Ctrl+Shift+F4 Data Source

42. Ctrl+Shift+) Full Screen

43, Ctrl+Alt+C Comment

44, Ctrl+K Hyperlink

45, Ctrl+] Increase Text Size
46. Ctri+| Decrease Text Size

15




47. Shift+F3 Cycle Case

48. Ctrl+M Clear Formatting

49 Shift+F7 Automatic Spell Checking
50. Alt+F12 Options

51. F1 Help

52. Ctrl+O Open

Chapter 4- Spreadsheet (Libreoffice Calc)

Free Online Computer Classes
@ Upciss Prime

Website
K WWW.upcissprime.com

j

Introduction

MS Office & Ms Excel & 3T Libreoffice # Libreoffice Calc & #m & WandA gidr g1
Libreoffice Calc Spread Sheet Program g, st Numerical Data @I Tabular Format &
Open, Create, Edit, Formatting, Calculate 3R print &Ra & &I FGr § Microsoft
Office # Excel u©® Spreadsheet software & 3dr @@ & Libreoffice & Calc ws
Spreadsheet Software § SF @R & Microsoft excel H & Thd g ag THT FeT 3T

Libreoffice Calc & & @aa & Libreoffice Calc =T File Extension .ods gl

16




Elements of Spread Sheet

[ Title Bar ] [ Menu Bar

/ ] [Sta.ndardToo] Bar ] [Formatt:inﬁToo]ba_rBar ]
i R l

[ Name Box ]

[Column Headers ] [ Formula Bar ]

~ '
E [ Row Headers ]
J

5 [ Scroll Bar

+ Sheg
[r——— t e \ Engiith (US4} I fuemage: ; Surm: 0 - o + 1o

[ Sheet Tabs ]

[ Status Bar ]

Spreadsheet- Spreadsheet a§ ¥l § &l IoR work &Xar g 3R Arithmetic 3R
Functional Calculations & Hef9d & &dr § BWice &7 37 Sheet-1 & & F AfAT fhar
STar & Sheet &1 a1 8 ST ST GohdT gl

Row- t& Row spreadsheet @1 Horizontal Sequence gdr § & Row & s} 1, 2, 3
e & I & J1fAg Far =7 § Calc & Row &ir @&ar 1048576 gt §1

Column-t& Column Spreadsheet @t Vertical Sequence gar &1 Calc Application =&
A, B, C & far aam g Cale & Column &r @ear 1024 AMI (A & AMI a=) g 3ifa# Cell
FT a1 AMJ1048576 FI

Cell- ts Cell, Row 3R &ad & Combination & fAat 0t gidr § cell § g7 e AT
3R B @ Y FRd B

17



Creating of SpreadSheet

eefic, 59 aafic Y g1 amar &, Libreoffice Calc & ter f3war g1 3w Ig ufeaat ik
TIHT FT T A5 § S 3T A 99, FIRIT HlaA, I Ufhar & eTHq §orar glCalc & [
IRl T 39ANT e 31eT Enter st & faT &S Spreadsheet File sa18 Sy £

Row Column Cell Sheet
LibreOffice Clac 1048576 1024 (A to AMJ) 1073741824 32000
Excel 2013 1048576 16384 (A to XFD) 1717989184 |  ----—---
Calc Spread Zoom Minimum 20% Maximum 400%

39 Libreoffice Open T § @ allel & WIS S T Fhd! 8-

Method 1 -Menu Bar ¥ File->New-> Spreadsheet @I 393 &t& New Document
Open &R THd &l

Method 2 — New Document Open &% & forw Ctrl+N Shortcut &r 393197 T Tohd ¢l

Method 3 — New Document Open &% & fov Standard Toolbar W New lcon =
Spreadsheet W click &% Open #X THd ¢

Concept of Cell Address [Row and Column] and selecting a Cell

@ig 3 Value Cell Address & gaRrT ggarir idr & 3R cell address Row 3R column &t
enfAer ar & Libreoffice Calc & Spreadsheet &7 9er glar & S aredfas TRAT 8T &
3R &9IRT rectangle & o glar § foeg cell #gr S1dar a1 9 Fg T & & T Cell Row
3R Column =T Setaaiael 8iaT &l

v’ Calc, & Column & letters (A, B, C) GdRT Jdfh Row &l &Rl GaRT YgdraAT ST g
v y3% cell F7 319 717 g8lar ¥ a1 Cell Address S 3a% 18 W 3MeRa &ar &
v’ Tgi 51 3ee0T & Column B 31k Row 2 &1 sedr & safaw sger cell address B2 gwm|

File Edit View Insert Format Styles Sh
A

B-E- H- D& 2l X

Liberation Sans e | |1'D pt ¥ | |

w2 s T =




v’ Cell Address Name Box # &ff R@rir &amr eret & &1 Cell dae gt W daf & Column
3R Row Headings 319ar 3m9 Highlight g st & 3k Name Box & 8ff fR@mriy &ar gl
Selecting a Cell- Cell @I Select &t & fav Cell W Fae &Y Select Cell & aRT 3R TH
a1t e@r$ &am 3R Column Headings 31T Row Headings & grselige forar ameem Cell as

de Select e 31 d& 6 319 a& Ac & R 3= Cell R Fasd 7 Y

5 vl fx 20 - =
N - B
1
2
3
4
| 5 | 1
i)
-
8

Entering Data [text, number, date] in Cells

Calc Spreadsheet # &5 YR & 3T &l 3¢ I Thd ¢ @A text, number, date 37T
3= Setting ¥ TSR 3T greT U I I S % fIT Manage X @ehd & IR g &
3mEET & Data Enter &¥ dahd &l

Enter Text or Number in Cell - Data Enter &% & fow worksheet & t©& cell WX click
Y 3R 3T FAI T TR A BT B 58 3T Gof T agd ¢ IR T Enter ar Tab &
9 H|

Calc # Data Enter a<a @& Numbers Cell & Right Side @39 gl ¥ 3t ¢eee Default
&7 ¥ Left Side er3g giar &1

Enter Date or Time in Cell- Clac # Date 3R Time &< &l & folw 3T Feler (/) AT g8
(L) @arr Date 31X Time @Y allel (:) 1 3TANT Feh el T Tehd & 3RO & fAT-

19/7/2024 a1 19-7-2024
v I3 3¢ & T Ctrl +; 3R @AT & T Ctrl + Shift +; HAS Aewe
Page Setupe

gor @1 @fder Sa- Page Size, Orientation, header and footer etc. & @€ &= & fow
PageSetup Option 39391 fHAT ST Bl

PageSetup #a & Format = Page Style>Page Option®r 393 #1|
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LibreOffice Writer # Page Orientation & 9&R & gId g Portrait 3R Landscape default
7 ¥ Page @r Orientation Portrait gidr gl

Organizer Page Area Transparency Header Footer Borders Columns Footnote
Paper Format
Orientation: @) Portrait
Margins Layout Settings
Left: Page layout: ‘Right and left ~ |
Right: Page numbers: ‘1_. 23 .. ~ |
Top: 0.79" = [ use page line-spacing
Bottom: o7e = Reference Style ‘ |
Gutter: Gutter position: ‘Left ~ |
[ Gutteron right side of page
Background covers margins
Help Reset Apply oK Cancel

Print Preview

Print Preview & gart Type f&U a1t Document &I &« & foiw &ia § fo 3mgsr Document
Print &tst ) 5T adir & e@rs gam|

v’ Print Preview &@er % fa¢ File Menu # S Print Preview Option W & Yl
v’ Ctrl + Shift + O 2iéhe T 3UATT HY|

Printing of Documents

v’ Document Print &&= & T File Menu # ST Print Option W e &¥
v Ctrl + P 2licshe &1 39T HY|

Saving a Spreadsheet

v’ Save #T & T 39w File Menu & Save & Fo Y|

vt new window R@$ 9| 5@ new window & location & TgeT *Y, Sier 39 File
@ Save T AES ¢
v 583 wEd 1 A ST a4 File Save &

20



=]
T &= » ThisPC » Documents w | Search Documents yel
Organize - Mew folder == - 0
cce notes desigr Mame Date modified Type
gyanxp Camtasia 7/18/2024 10:05 PM File folder
|_-| Applicatiun Links Corel 202 File folder
Custom Office Templates File folder
@ OneDrive - Persor FeedbackHub File folder
I This PC My Data Sources File folder
My Palett File folder
B 30 Objects v Palettes ile folder
[ Desktop
=] Documents
I:-l v £ >
File name: I Untitled 2.0ds I ~
Save as type: I ODF Spreadsheet (*.ods) I ~
[~] Automatic file name
extension
[] Save with password
] Encrypt with GPG key
Edit filter settings
A Hide Folders Save Cancel

Opening and Closing

Opening Spreadsheet

File Opening & aRg &I g1 Thcl § Tk s ®igel & 3N a0 Hrs o IRad Fa & fav uga
4 Aislg Brsc| dfthel fohell ot BT &l 9 i & g AT H 6 s Save fohar ST
T & AT |

frafAf@a VT #T T T 9gd F Tl 1T B HGT F TFS ¢
Method 1 -Menu Bar ®X File & Open d@rer 3R wisel &f Salect aX & 3 wrser &1

Open &= &l
Method 2 — 9gar & &=t File Open &%=t & faw Ctrl + O Shortcut &7 39AFT HT Thd gl

Method 3 — ggar & &=t File Open &t & fav Standard Toolbar 9T Openicon W
click & 3R wser & Salect #¥ 5@ ff wEsar A Open HLT gl

&

File Edit View Insert Format Styles Table Form  Tools Window Help

B-10&[@ L= A q Bl B HE
|DefauItParagraphSter V|':,%¢ ,%ﬁ |Liberatiu:rn5erhc V||12pt Vl B I U~ & X2 X, i%) &v

= Ll 1 2 3 4

i L x I e n I n L n

F
ur



Closing

v Spreadsheet # Open Document & §¢ &<« & faw File #F @ Close fFwew @
3UANET Y|

v’ 71 5T Menu Bar & Right Side & X Button & 392 &Y|

v’ Ctrl + W 2iiéhe T 39T Y|

Closing LibreOffice

4 i alie ¥ LibreOffice & Close &% & v File Menu # Se Exit LibreOffice, @@
Click ®71

v' Ctrl + Q elfi¢ahe T 3UANT HL|

v’ 71 fe Title Bar & Right Side & Close(X) Button T 3u2er Y|

Manipulation of Cell & Spreadsheet

Modifying / Editing Cell Content
FIT-H T T IRT 3T gerv o= Cell & data &' Edit & grar g

Using the Keyboard- #1&1s &1 39391 &3am

v’ Cell #rSelect &

v F2 hofl gaTl 3R HE Al & 3 F @I ST |

v St 3ma Cell & =1 e for@eT agd §1 98f W X 97 X 3R f-a1% Arrow Key @
3UANET |

v/ 59 New Data Type & o, ar Enter il gamd|
Using The Mouse - AT3HE &T 393197 #I&

v’ Cell ) Double-click & & el 3R Fueal & fow Cursor &I del # W

Formatting Cell (Font, Alighment, Style)

v/ Cell X Right Click &Y 3k Format Menu Click &

v a1 3 @1 B &= & v Format = Cell W ST

v/ a1 B Format Cell Dialog Box Open &% & faw Ctrl +1 2iiéae Press Y|
v Cell & 3 s Format @ & 38 Format W Click &Y 3k OK W Click &Y
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o

MNumbers Font Font Effects Alignment Borders Background Cell Protection

Category Format Language
Al [Default - English (USA) v
User-defined 1235
23457
Percent 1,235
Currency -1.234.57
Date -1,234.57
Time (1,235)
Scientific (1,234.57)
Fraction one hundred
Boolean Value One hundred
Text One Hundred
OMNE HUMDRED -1234.56780012346
Options

Decimal places: I:l U Megative numbers red
Leading zeroes: [] Thousands separator

Format Code

General

Help Reset oK Cancel

Format Cell Dilogbox

General - Cell & ag Format ¢aee 3R FE&ITHT el I dof H TAHR HT gl
Number - Cell &7 Ig Format &add T&IcHS TAHR adT &l

Long Date - Ig Wisfc shae Date 3R Time & HAEAT & TSR HIAT ¢

Percentage - 8 oRg T Format &ddl H&AcHS dog &l FHR Al § AN 38 % gfaerd
Symbol & & wefid &ar g

Fraction - 38 dig &l Bidc shad haeld ¥ 2.500, 3.345 3nf¢ & PR AT &l
Scientific - ag Wi AEefher dog a1 T AT HHARIOT deg T FHR AT &
Custom - Tg AT IR HT Ueh FHTCH BiHC ThN HT YA ol I JAUT & &

Changing Font Size, Color, and Style

7 @T Option & 39dT Format & & forw fhar amar & 31k & Option Formatting
Toolbar # feu g gl
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Untitled 2 — LibreOffice Calc

File Edit WView |Insert Format Styles Sheet Data Tools Window Help

B-a-H-D& QB X BB 2 4 o
Liberation Sans ~| |10pt |~ B I u - ﬁ bl ﬁ‘ﬁ b EE E EE
Font Size Color

v’ LibreOffice 7 R%fee Font Style Liberation Serif T &

v’ LibreOffice & Formatting toolbar & Color fa®ed &7 39T &< Text @ Color far

ST gehdT B
v

Cut, Copy Past and Paste Special

B Untitled 1 — LibreS#ice Wr

File Edit View Insert Formd rmm Tools  Window Help

B-E-E-0e Byl 2 5% 9 I H - L

Cut - Selected Cell &I Te TT & gl gAY TUH W o S folw Cut Option 39Ner fohan
ST g

v Cut #tr & fav Edit>Cut & =aeT &t
v’ Ctrl + X 2if&ahe &7 39T |

Copy- Selected Cell @r Duplicate Copy st & fow Copy Option @ 39dier fehar STar
gl

v Copy &=t ¥ faw Edit>Copy &1 7o &Y
v Ctrl +C 2ii¢she T 39ATT H|

Paste- Cut ar Copy &3 1T Text &I Cursor & ¥U W (WA & foIv gHHT 39T fohar
ST g

v Paste &% ¥ fav Edit>Paste & T &t
v’ Ctrl +V 2i&he &1 393197 |
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Paste Special- Paste Special option T copy &=t & dIc & enable giar g ifeher Paste
Special &% garT g4 copy f&U gu Data =l AT & AT o Paste X Ul 3MTARIBALTAR
Format # Paste &X ¥ad g Paste Special @r Shortcut Key Ctrl+Shift+V gicr § |

v' Edit - Paste Special - Paste Special. & 39T &Y

Untitled 2 — LibreOffice Calc
File | Edit = Miew Insert Format Styles Sheet Data Tools Window Help
- Undo Ctrl+Z b O - a
U ol A Jo
edo Ctrl+Y
Liber. Repeat crsshit=y |B I U~ AR .| = = =
X Cut Ctrl+X |
D5 fo M
[ Copy Crl+C  }
™ Paste cr-v | NCEEN E | F G
12 % Paste Special »  |5| Paste Unformatted Text Ctrl+Alt+Shift+V
3 | BB selectan Cirl+Shift+Space | || Paste Only Text
ﬁ B Select v | [T] Paste Only Numbers
6 /r:;. Find.. Cirl+F ix|  Paste Cnly Formula
7 Find and Replace... Ctrl+H = Paste Transposed
8 -
9 E‘@) Track Changes b Paste Special... Ctrl+5Shift+V
10 Cell Edit Mode F2
11
v :
1 Cell Protection
13 Links to External Files
14 OLE Object
15 B
16 Edit Mode Ctrl+5hift+ M
17
im

Changing Cell Height and Width

Changing the Row Height- ®sfic & Selected Row #r height Is1 #=at #
fafafaa fafer §1 @& Row Select ¥ fG@dr height 3T se@r aga £

Cell Select #& Format Menu # S Row 2> Hight &I Jeiedc & 3U% THA Teh
SrIdieT Sigd fe@Ts &M Row Hight T 3 T Enter &Y 3R OK X Click &Y

Paste Special- Paste Special option &t copy &=t & dIc & enable giar g ifeher Paste
Special & gaRT &A1 copy fHU gu Data & S & <A o Paste & el HTTRIFATAR
Format & Paste & @&d g Paste Special @r Shortcut Key Ctrl+Shift+V gicr gl
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v/ Edit - Paste Special - Paste Special. & 39T &Y

Window Help

i nl

Wl 2

(]

Paste Unformatted Text Cirl+Alt+Shift+V

Cirl+5hift+V

Changing Cell Height and Width

Changing the Row Height- wsfic & Selected Row & height 5 &= #
faafaf@a fafer §1 @& Row Select ¥ fG@dr height 3T se@r aga £

Cell Select & Format Menu # S Row 2 Hight @I Joiede ®{ 3G%H THA T

Untitled 2 — LibreOffice Calc
File | Edit View Insert Format 5Siyles Sheet Data Tools
, Undo Ctrl+Z k 2 -
. T EkBRR-s 4
Redo Ctrl+Y
Liber. Repea Ctrl+Shift+Y B I U -~ A -rl o,
X Cut Ctri+X |
D5 -
— [|=_£| Copy Cirl+C |
% Poste iy | D c
1 a =
3 7| Paste Special =
3 | FH selectal Cirl+Shift+Space | |3 Paste Only Text
ﬁ B Select v | [T Paste Only Numbers
6 ,'::' Find.. Cirl+F Jx|  Paste Only Formula
7 Find and Replace... Ctrl+H | Paste Transposed
8 o :
g E&) Track Changes v | [?] Paste Special...
10 Cell Edit Mode F2
11
»  Cell Protection
12 -
13 Links to External Files...
14 e I-\'i':"__
15 B
16 dit Mode Ctrl+Shift+M
17
18

SrIelter aterd @S &M Row Hight &r &g &I Enter &Y 3R OK W Click &Y

3 &1 Row Column a1 Cell Insert &t Imga &1

Method 1 — Sheet=>Insert Column/ Insert Cell/ Insert Row

Method 2 — Column ar Row @ Select &Y 3Rk mouse 9 Right Click &Y

Insert > Column/ Insert Cell/ Insert Row @I Telge H|
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Sheet  Data Tools Window Help B

Selection
R -
Insert Cells Ctrl @® Shift cells down

Eﬁ Insert Rows O shift cells right

g
) | o
I_J;l Iﬁ Insert Columns k

(O Entire column

Insert Page Break k
- Help oK Cancel

Delete Row, Column and Cell
38 Column ar Row &1 Select &Y {51 & 39 Delete &= Iigd &1

Method 1 — Sheet—> Delete Column/ Delete Cell/ Delete Row
Method 2 — Column ar Row @ Select & 3Rk mouse 9T Right Click &Y

Delete = Delete Column/ Delete Cell/ Delete Row = Tdac |

Sheet Data Tools Window Help 52
E*:E Insert Cells... Ctrl++ Salection
B Insert Rows r (® Shift cells up
@ Insert Columns ’ ‘ (O Shift cells eft

Insert Page Break c O Delete entire row(s)

(O Delete entire column(s)
Delete Cells... Ctrl+- =
Delete Rows

Help OK Cancel

S 5 54

Delete Columns

Hide/Show Row, Column and sheet
38 Row I Column &I Select &Y foieg 39 Hide a1 Unhide e =ga &

v" Format=>Row=>Hide or Format=>Column->Hide
Sheet = Hide =t & foT

v Format->Sheet->Hide
Hide f&t a1t Row, Column 3R Sheet & Show & & foiT 37 Options T 39T &I |

v’ Format->Row/Column/Sheet->Show
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rt  Format Styles Sheet Data Tools Window Help
Text J

[ A = & A .
Align Text b
MNumber Format v A - ﬁﬂ - ; ;

Clene Formatting

Clear Direct Formatting  Cirl+M

=1
= Sl e

| Cells... Ctrl+1 2 | F -
Rows » O Height..
Columns » U$D Optirnal Height...
= Merge and Unmerge Cells » | [ Hide
Character... L Show

AutoFill

Spreadsheet # automatically ¥ & AutoFill Command 3ar Series Command & @1y
greT el 7 R T T
v’ w& Cell # Click %Y 3R & Number 159 &
v 5 377 Cell F Click &Y 3% f 37 Cell 3 am click &Y et 3m9sr Number
Trsy fohar am|
v’ Cell % faaar Right Corner # frer EfRe 397 #Y oo 3T o ared § 3K A9
g & BIS G|
v/ Cell # ¥ 3R FEam & Y SCA|

Using Fill a series

v" Sheet Menu->Fill Cell>Fill Series

Styles | Sheet Data Tools Window Help

T % Insert Cells... Ctrl++
.__\’. =
E;j Insert Rows »

it | ﬁ Insert Columns »

b —

i 2
B
_)||‘ 3

Slle E
l|l< é;ﬂ

Insert Page Break r

Delete Cells... Ctrl+-

C H L& |

(]

Celete Rows

58 S

Delete Columns Direction Series Type Time Unit
Delete Page Break 3 @ Down @ Linear
Insert Sheet... Ri (O Growth

Insert Sheet at End... @) Up ) Date donth
Insert Sheet from File... _:_._ O Au;:oFill
External Links... B

Delete Sheet... Start value: |4 |

5

X ClearCells... Backspace
Cycle Cell Reference Types  F4
Fill Cells b

End value: | |

Fill Down Ctrl+D Increment: |1 |
Fill Right
AL® Help oK Cancel
Fill Left

Mamed Ranges and Expressions »
|.‘,__| Cell Comments »

CEEH

Rename Sheet...

Fill Sheets...

Fill Random Number...

Hide Sheet
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Sorting & Filtering

Spreadsheet # data @& AT H1H FId THT §H HFAX dgaX SIARRT ol fAhrerer IR cgafead
el T T gl & ST% 37T g4 Calc & T §XoT Srered Tool & 9 & 39ATer &7 Foha
¢ 3R gAR Data ¥ 3NN SR & folv W 99T Y& Hehd g a1 Sorting 3R Filtering
Tool @T 39dlT & fhar sirar § Calc & Sorting 31X Filtering & Standard Toolbar &
Sort 3R filter @dFereT &T 39TRT ek TFaH T SITar & a1 T Data Menu & ST agi
¥ g4 Data &I Sort 3iR Filter & &&hd gl

£ Sheet Data Tools Window Help
W E| Sort...

Sort Ascending = :J, E\L l?
5 — =~

Sort Descending
(&g ~

—_
£

— I

-
L

AutoFilter Crl+5Shift+L

Maore Filters b

ol

-

—I— Define Range...

Select Range... | I

%EE %] €

L=t

Ih
1

Sort - 5@ Option $I Ace & &F 379 3T &l Sort X Tohd & STHH &H Tdh Y 3cTaT-37eTaT
FIH F Sort T oha gl

Sort Ascending - s& Option & ATETH & §HF 3YeT 3T I ARIE FA 7 Sort F Thd &
SIS §H 39 3T @l Select o 38 3o W Click &1 a9 U srgeller sied geolanm o aqs
TFHES 3N e TfeleerT Ao Ifg vaads W gH Click &t OK e ad gART foide o
Column g &9 Select g STwam T2m Sort 8 g SN @ifthd 3R g7 de RedE W
Click &3 d9 gART dgr 31er Sort g SRl A= Select foam |

Sort Descending- s@ Option & #A”IA ¥ gH 379 Data N A& HA & Sort &
Thd gl

Auto Filter - & 3ifwesr @ g& Calc &1 Data # Filter Add &< @&a § @@ 9ga A
Data @l Select &3 38 §1¢ 58 Auto Filter 9X Click &%t ar @& dgel ol & T Drop-

Down Icon 3 Siwen 5 oY Click &% g7 319« Data &1 $=oT 3R fiheet 3R Sort
X Fehdl ¢ S Data gH fe@rewm g1 fe@r Gohd € a1 QUi g1 38! g4 9T Fohd ¢
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PRODUCT NAME |PRICE QUANTITY TOTAL
S KEYBOARD 350 2 700
SIMOUSE - 100 4 400
S MONITOR 3000 3 9000
S|UPS 1500 2 3000
JWEB CAMERA 1200 6 7200
MODEM 400 3 1200

sqaT YfFedher UPCIIS Prime YouTube channel 9 &I—&T 13T

Freezing Panes

aﬁ%w%m@raﬁﬁ%mﬁw%sﬁ%&ﬁt%?wa%sr@amﬁﬁrgtr%,a’rm
3¢ WIS X Thd g, fordd 3T AV 32T P Thiel ad THT HIed AT UfFdAT & Hhd gl

Freezing Panes # dis & #Algg da €

1. Freeze Row & Column
2. Freeze First Row
3. Freeze First Column

Freeze Row & Column

Freeze sa & T View menu W JT 38 di¢ freeze Cell & Eﬁ 38 di¢ Freeze
First Column arRow @t gFT

View Menu=> Freeze Cells>Freeze First Columns or Row

Unfreeze Panes

Row & Column &I Freeze ge & T a1 af A s W @ 3R Unfreeze rows 3R
Column @ Select % a1 #&T gl # Unfreeze Rows 3R Column Icons X Click &Y

Untitled 1 — LibreOffice Calc

File Edit View |Insert Format Styles Sheet Data Tools Window Help

. EH Normal [“B < & i&p Z;\ .
] Page Break

Liberation 5| User Interface... u - A - ﬁﬁ -

|

Toolbars (5
H17 -
Formula Bar

n

Status Bar | E |

@ B[S [0S

View Headers

View Grid Lines

Grid and Helplines »
Value Highlighting Ctrl+F8

Hidden Row/Column Indicator

N

Show Formula Crl+"

Comments

=

Split Window

3]

Freeze Rows and Columns

]

ORI (I H

Freeze Cells 3 Freeze First Column

B

un

Freeze First Row

Sidebar Ctrl+F5
Styles F11
Gallery

Navigator F5
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Formulas, Functions and Charts

Using Formulas for Numbers (Addition, Subtraction, Multiplication & Division),
Teh GIHCT Teh TehR 1 THEYRNGT & Sl Teh Hel & o i 0T Sl g Function Wgel & &=
g Formulas g g, et 93T ffe R & Calculation & & faw fFar arar &1

LibrareOffice # 319 & YR & W $H U & Hehdd § AT SRREFC Hel # TBY Hleh AN
B = A5 ¥ YE BT § oI T BEfer fo@er A aX & a9 Enter key 98 Y|

File Edit View Insert Format Styles Sheet Data Tools Win

B-E-B- D@ XBmE-4.

|LiberatiDnSans V||1l[]pt V| B I u - A
|B? v‘ fy 24 v = | =B3+B4+B5+B6 _[ Formula Bar ]
.
]
2
3 10
5 25
6 35

- 5 o )

Autosum- Spreadsheet # 3iferga ©s Function & for@er 39alr @#g o= & AT
o g Foleh H TEA3MT Al Taeifold &7 § Sl & fov fhar S g

v 3% Cell # Select ¥ 3 3 Row a7 Column & 3id & feud & O 39 SirseT =g &
v’ Formula Bar ¥ qrd Sigma lcon W feFefer Y 3T 31T 513 A & Sum  TForeh &Yl

Functions (Sum, Count, MAX, MIN, AVERAGE),

File Edit View |[Insert Format Styles Sheet Data Tools Window Help
B-B-B-D&R X 5HhME-18 49- JOR AN R |
|LiberationSans V||1Opt V| B I g - Avﬂv EE E EE ? % :i %
e13 V]l ez

" | i N E F | G
1|
2 ltem Qty Rate Total Amount Slgma
3 Keyboard 5 350 1750
4 Mouse 6 250 1500
3 pen Drive 3 300 900
6 Printer 4 5000 20000
7 Monitor 2 3500 7000
8 Grand Total 31150 ||
| 9 |
10
11
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Sum - =g % & 393 Cell Values ar Range of cells & Jigat & forw fxar arar &

=Sum (A3:A6)

SUM V| fx X | =sumiazae)
A 8 |

5] SUM

2| Number Result

- 50 172
n 40 =SUM(A3:AB)|
E 52

o 30

Count - =ge 39ahr Ru a1t O« I § T&IcAF A & [ & faw fFar sar
=Count (A3:A6)

|COUNT | fx X  [=countiazag
A I

N Count

2 Number Result

. 10 4
n 15 =COUNT(A3:A6)
s 12

E 10

Max - & werere 1 398097 I T & 7S T F 3RAIA (maximum) FeT & F T

forar ST §1
=Max (A3:A6)
MAX V| fx X | =maxazag
A 8 |

M Max

2 Number Result

3 10 15

. 15 =MAX(A3:A6)|
5] 12

6 10
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Min - 5@ b &1 37T A H & T I F FFAGA (minimum) FeF & F T fFar

ST gl

=Min (A3:A6)

MIN

v\ fx X « | =MIN@A2:A)

A I
7 Min
2| Number Result
: 10 9
n 15 =MIN(A3:A6)
5 12
: 9

Average - sg BRI & 39T Ao H & S I & degcAS AT # 3ad Fehes &

forT R Sirar g
=Average (A3:A6)

AVERACE o ) I8

A

fx X & | -AVERAGE[AZ:AG)

. Number

Average

Result

10
15
12
9

11.5
=AVERAGE(A3:A6)

Charts (Bar, Column, Pie, Line)

IE ST AT Hedl & Toh w27 glaffRicd § o g Tffeera &0 @ saredn ar Jofell adel &l
3Rl 3T B1 THAS A =€ 9 AT H ST A AN A1 RN A F A WA 8, o

SATEAT AT 3T &1 ST &

Libreoffice calc & a1¢ 10 YR & g gl

1. Column chart
2. Line chart
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3. Pie chart

4. Bar chart

5. Area chart
6. Scatter chart
7. Stock chart
8. Surface Chart
9. Doughnut chart
10. Bubble chart

11. Radar chart

Choose a Chart Type

il Column

|:'_ Bar - [l ™

oo Ih | B2 |EE
rea

3. Data Series E Line

4, Chart Elements l"_‘ XY (Scatter)

E Bubble (130 Look |3.Es istic

@ Net Shape

|isn Stock

m_TI Column and Line

Mormal

Help < Back Next > Finish Cancel

¥« Popular Chart Column Line Pie 3R Bar chart 2|

Column chart- siem ar& & v g7 & 7 &7 & 310 zer # JolelT el & oI &
Fohd Bl 3@ A€ H ST & & & H G@rg oar §1 5@y Gergar @ ser @l ol Hiel
3T g ST €1 Cale & g@nr & are & By Default Chart define fram s g1

FIeTH dIC T TIAT

Step to Apply: Select Data Range—Insert Tab—Chart—Column Chart
FIAA TIE H T A aF F AT 317 fAeT &7 vt : -

v 3T IS @ Ao W
v 38& 915 Insert tab I S|
v s 9 # Column chart 3T W Fos Y
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W 00 s |En LA R

b | b |

17

a0

v 3T 3T TR 3eTAR qre &l

AN

AN

. B | C D 1 G
S/N Name English | Hindi
1 sudhakar a0 so |

2 Akhilesh Kumar 35 38

3 Bhola Kumar 36 39

4 Rakesh Kumar 43 51

5 Pramod Kumar 31 52

6 Raju Kumar 55 60

7 Ajay Singh 48 37

8 Vijay Singh 46 52

3 Aman Kumar 33 43

10 Sonali Verma 36 65

11 Pooja Kumari 51 45

12 |Kumari Anjali Verma 55 37

13 Ram Sharma 31 a0

14 Pawan Kumar 37 51
15 Amod Singh E 42

[rata Range

dolde HY|
H I J K L

70 -

60 -

50

40

30

20

10 -

0 R | R | R |
e sl Bl s B Sl s 2T B R g <
dHEHEHHEHEHEEHEEE
s 222|202 22528
HEERFIFE R RFIEE R
2|2lg g\ & |=|E 538\ =5 2%
b=l Bl I Llim|a|Z| =g
= =& E

2

1(2/ 3| 4|5 6|7(8(910/11|12|13 (14|15

M English
B Hindi

Cylindrical Column Chart

Line Chart-a'ls?rﬂ'lﬁﬁ?;mﬂ;@w A Yefd @l darell lines Horizontal (81f3<T) lines
Bl &1 ST lines 1 ST §H AT @ T Tolell FX Hehdl § T Plol-chled § ST T A e
3R Traem ser ar ger §1 3 A oY 9gar oPmAT ST Jhar § A HiT T gHI H Fdar oar

TS TTC T TATT
Step to Apply: Select Data Range—Insert Tab—Chart—LineChart
A 1€ F YA FH a1 & AU 39 AeT Teow wrar #1 -

vV g9 TEd 3T IS & doee
v Insert tab W S|
v’ Line chart 3ifcer ©T Fas &Y

V' T N9 TGATFAT 3TAR 39 GEE T IIC T Jolac HY|

A B L c D ]
1 §/N Name English |Hindi
2| 1 Sudhakar 40 50 ¥
3 2 Akhilesh Kumar 35 38
4 3 Bhaola Kumar 36 39
5 4 Rakesh Kumar 43 51
6| 5 Pramod Kumar 31 52
7 6 Raju Kumar 55 60
8| 7 Ajay Singh 48 37
9 Vijay Singh 46 52
10 9 Aman Kumar 33 49
11| 10 Sonali Verma L 36 65
12 1 Pooja Kumari \ s1 45
13| 12 |Kumari Anjali Verma 1 55 37
14 13 Ram Sharma | 40
15 14 Pawan Kumar ‘3? 51
16 15 Amod Singh \aa a2
17 L
18 Data Range

"
=]

G

70
60

50
40 -

30
20
10

35

Line Chart 20

H I J K
T T T T T T T
¥ & % 5 ¥ B £ £ 5 ® R F @ ok £
S E S EdEg2EgcEfREECEE
£ 3 3 53 3 3 A in 3w 5 » B8 3 @@
T X ¥ ¥ w X ¥ > g P> L X 4
:I-l:m.cu:‘t&!‘_tc:m:mco
" T T2 e FT5 2 EESEESE
= £ £ E = E 5 5 E = <
£ @ ® 8 < 4o = = F
= ©oa =
E
E]
=

——English

——Hindi



Pie chart - og o€ ¥aa a8 oITa] BIcT § T8l shaol Teh ST AT Bl FHeHT &aT JAThR gl
g 3R 3w Tt Ao 3remT - 3rorer TNt F fe@mr S §1 3w 5w de 7 died deg A e
REAeRY 38T § 3d« fe@mr Sirar g

91 9T¢ HT FIT9T

Step to Apply: Select Data Range—Insert Tab —Chart —Pie Chart
91§ II¢ FT TAT FA & AT T ToH el HY -

v 95 31T AT F A H

v 38% 415 Insert tab TR e

v’ Pie chart 3ifeereT R e x|

V' 3 3T AR HTER AU TG B ATE H Fowe R

A B . G H | ] K L M N C
1 §/N Name English
2 1 Sudhakar 40
3 2 Akhilesh Kumar 35 =
a4 3 Bhola Kumar 36 EngIISh
5 4 Rakesh Kumar 43 = Sudhakar
6 5 Pramod Kumar 31
7 5 Raju Kumar 55 oo % m Akhilesh Kumar
3 7 Ajay Singh 48 58 ™ Bhola Kumar
9 8 Vijay Singh 46 : W Rakesh Kumar
10, 3 Aman Kumar 33 - = ® Pramod Kumar
11| 10 Sonali Verma 36 = Rajus Kumar
12| 11 Pooja Kumari 51
13| 12 |KumariAnjaliverma| 55 W AjaySingh
14| 13 Ram Sharma 31 5% W Vijay Singh
15| 14 Pawan Kumar a7 Aman Kumar
16| 15 Amod Singh | 44 )
1 Data Set Ple Chart 2D

-
o

Bar chart-sk @€ (Bar Chart) Ffer o€ &1 R t &9 & =@ off o€ 1% & &7 & @S
ST § 9T 3R STl § T iedd are Fearer (Vertical) g1dr § 3R SR ar¢ Horizontal (&ifa<)

T I1C T 9T

Step to Apply: Select Data Range—Insert Tab—Chart— Bar Chart
Bar chart &T 39417 A & AT ¥ TEH BidT FX -

vV #e8 Tge ST I & Yo
v 38& 915 Insert tab I S|
v’ Bar chart arer 3ifeeed o e FY|
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v’ 319 31T 3797 AFUEE $T Bar chart Y JoaT Y|
vV Fad S F {d §Te Bar chart gordllc W fe@ar 9|

A B £ D G H | J K L M N

1 S/N Name English |Hindi_k *

2 1 Sudhakar 40 50 AmodSingh I ———

3 2 Akhilesh Kumar 35 38 —_— =
 aaa

4| 3 Bhola Kumar 36 9 . essees——— e

5 4 Rakesh Kumar 43 51 Pooja Kumari | e

6 5 Pramod Kumar 31 52 I

- -—

7 6 Raju Kumar 35 60 Aman Kumar & Hind
g indi

8 7 Ajay Singh 48 37 : Ajay Singh | e e )

9 8 Vijay Singh 46 52 S W English
T

0 9 Aman Kumar 33 49 Pramad Kumar

- "

11| 10 Sonali Verma 36 85 Bhola Kumar I S S——

12 11 Pooja Kumari 51 45 I

13 12 |Kumari Anjali Verma 55 37 Sudhaker | —

14 13 Ram Sharma 31 40 0 w 20 Yo 40 so s0 70

15 14 Pawan Kumar 37 51

16 15 Amod Singh 44 42

17

18 Bar Chart 2D

19

Shortcut Keys for LibreOffice Calc

Shortcut Keys Effect

Ctrl+N New Sheet

Ctrl+Shift+N Manage Templates

Ctrl+O Open

Shift+F11 Save as Template

Ctrl+S Save

Ctrl+Shift+S Save As

Ctrl+Enter Next Line

Ctrl+Shift+0O Print Preview

O 0 N o AW N e

Ctrl+Q Exit LibreOffice

Ctrl+X Cut

=
o

=
=

Ctrl+C Copy

Ctrl+V Past

=
g
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13. Ctrl+Z Undo

14, Ctrl+Y Redo

15. Ctrl+Shift+Y Repeat

16. Ctrl+Shift+V Paste Special

17. Ctrl+Shift+Space Bar Select All

18. Ctrl+Page Down Go to Next Sheet

19. Ctrl+Tab Go to Next Sheet

20. Ctrl+Page Up Go to Previous Sheet
21. Ctrl+Shift+Tab Go to Previous Sheet
22. Shift+Space Bar Select Row

23. Ctrl+Space Bar Select Column

24, F2 Edit Cell

25. Ctrl+H Find & Replace

26. Ctrl+F5 Show / Hide Sidebar
27. F11 Show / Hide Manage Style
28. F5 Open Navigator

29. Ctrl+Shift+) Full Screen

30. Ctrl+F2 Insert Function

31. Ctrl+Alt+C Comments

32. Ctrl+K Hyperlink

33. Ctrl+; Date

34, Ctrl+Shift+; Time

35. Ctrl+Shift+P Superscript

36. Ctrl+Shift+B Subscript
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37. Shift+F3 Cycle Case

38. Ctrl+Shift+6 General Format

39. Ctrl+Shift+1 Number Format

40. Ctrl+Shift+5 Percent Format

41. Ctrl+Shift+4 Currency Format

42. Ctrl+Shift+3 Date Format

43. Ctrl+M Clear Formatting

44, Ctrl+1 Cell Formatting

45, Ctrl++ Insert Cell

46. Ctrl+- Delete Cell

47. Ctrl+D Cell Data Copy to Down Cell
48. Ctrl+F3 Manage Names

49, Tab Go to Next Cell

50. Shift+Tab Go to Previous Cell

51. F12 Group Cell

52. Ctrl+12 Ungroup

53. Shift+F7 Automatic Spelling Check

Free Online Computer Classes
@ Upciss Prime

Website
S WWW.upcissprime.com

39




Chapter 5 - Presentation (Impress)

Introduction

LibreOffice Impress # Microsoft Office & MS PowerPoint S&T & Teh Presentation
Program g| for&erT 93197 Slide Show IR &3t & foIT foham SITar &1 88 &4 379« Information
&I Graphics 3R Multimedia & #ATegA & Present &Xa g1 LibreOffice Impress &7 File &7
Extension Name .odp gar &1 Saerak Companies 39eT Presentation ¢t & foIT 39 @@
% Software T & YT AT &, FAITh STH $& Advance Features gia g, o1 Use g
3790 Presentation & s Time #X @hd gl o8- Custom Animation, Slide Transition,
Slide Effects etc.

Creation of Presentation

Impress & #&a window & i g€ g1d ¢ - Slide Pane, Workspace 3iR Sidebar| 3maer
3 ol OR fe@rs &9 St Ut e fhue vd wie aA dT glawr gerT wd g

=] S 2=
File Editl View Insert Format Slide Slide Shi
E--@-10 & - HE-BE T2 E - B Fes 83-BE =-
b alL-B-\OO-% -y -0 13 = A &
Slides x | i Properties Ho=
1 Toolbars e E
~ 7/ Format: |Screen 16:9
= . Orientation: |Landscape '9{‘
. CIICk to add Tltle Background: |None [
Insert Image... @
Master Slide: <>
A 4 Master Background
[ Menu bar ] )  astr i =
Title bar et
Click to add Text | i =
BB
0l (=]
L [
1 [ [ [
Slide 10 1 Default 4437704 1= 000x0.00 English (USA) B — ——+—++  76%
\ 4 \ 4
[ Slide Pane ] [ Workspace ] [ Sidebar ] [ Sidebar ]

Creating a Presentation Using a Template

Templates FT 3TINT FIQ §¢ New Presentation ®I Create #3d & faT ¥eU-
40



v’ File Menu>New->Templates X S0 a1 Shortcut key Ctrl+Shift+N & g2 Y|

v’ t& Template Dialog Box e WX @S &M 39 379+ 93 & 3TER U @l Select
#¥ 3R Open W click &I

| Filter |Presentations ZI IAII Categories E‘ Manage ¥

Lisrven fppmnt
Leren Ipsem
Ducr 56 Amat

Beehive Blue Curve

DNA Focus Forestbird Freshes

Growing Liberty
Impress Template

Grey Elegant Growing Liberty Inspiration Lights

Creating a Blank Presentation

v’ File Menu>New~> Presentation X sT¢ a1 Shortcut key Ctrl + N &7 93T &1|

v’ w& Template Dialog Box &R W @S &M 319 319+ 9¥ig & 3TER U @l Select
®Y 3R Open W click &Y =& ar Template window &I &c & Thd ¢l

Inserting & Editing Text on Slides

v Slide Menu-> New Slide T8 3¢ |
v" a1 Shortcut key Ctrl + M & S=er Y|
v’ Standard toolbar @ 39aT #%F New Slide s Tea & 34T Figure # fe@mr mm &
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Ia o || &

22
File Edit View Inset Format Slide SlideShow Tools Window Help &
BE-E5-B-10 & Ey ©) - A HEO-B TZE E-EEih E Fe a3-BEI=-
FRL-L-NOOI=-¥-L-0-Q-=-B-O-%-0-[3 - A £
Slides x i Properties =
1 [ wescome Slide N
T Format: |Screen 16:9 ,A
\pcizzPrime I' k dd - | Orientation: |Landscape 4
i Click to add Title -
Insert Image... @
* Click to add Text Master Sice: o
Master Background
Master Objects =
Master View
B e
Il (I
0 ] =]
=0 &2 B
[ [ ] -
o =
[——] [——] [——]
= E =
[ [
>
Slide 2 of 2 Default tI517/7.00 = 000x000 |12 English (USA) $ -t 7%
E—

To Add a Text Box - Text & Placeholders 31k Text box &t # /el T THhaT &

Text box insert %=t & 319 Slide Layout & S13 @hd & Placeholders & faudia Text box
gHT Tk & TAT W Ed & HAl & 39 Theme §co &l

Presentation & text box J3a & fAT fRU T FTH & Hral HY-
vV SHE Ao @ oee ST F Jolae L AT

v Fags W Text Box & @@t & faw Click, Hold 3R Drag &Y Text Box fR@rs am
¢FEe Sz for 98 Text Box W fFeeh oY AR @9 e Y& |

Deleting Slides in a Presentation
fAssT ¥ & gaRT Presentation # ¥ slide F1 delete FT TFHA &-

v 37 Tomes # Select Y 3 3T delete RS & Slide Menu W &i@ delete Slide &
Click &I

v’ 317 Selected Slide @ Delete &%er & fw mouse W right click &Y 3 Delete Slide
9T click &Y

Saving a Presentation

v’ File menu # ST save W click &Y
v’ I toolbar & ¥ icon WX click #Y|
v’ 31 shortcut key Ctrl + S & 39T FY|
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Manipulating Slides
Inserting Table

Slide & Table Insert I & T 3T Steps FT UTeleT FI-

Go To Insert Menu > Table WX click #¥| 39% §1¢ 3O <o ST diad @S &I
AT FTRT & A & Column 3R row & T&AT Insert &Y 3R OK sed 9X click &Y

few 7T R Y GEgIdr ¥ g« fFue & VT F 3@ THd &

E Untitled 2 — LibreOffice Impress

File Edit View  Insert Format Slide Slide Sh
s Audio or Video...
s @ | &t chat. —
— <
— D Teble.. Mumber of columns: 5 =
[ Media v
1 OLE Object v -
Mumber of rows: 2 -
I:@ Shape » &5
Snap Guide...
z Text Box F2
|.V__| Comment Ctrl+Alt+C ﬂEIP QK EEFH:E'
F Fontwork... i
|
A Hyperlink..  Ctrl+K
Special Character.

Click to add Title

Adding Clip Art Pictures

Frg 3c Ifhehel shec g TolaahT 39T Presentation &7 slide & frar ar @epar &
Presentation & 3991 fir St arelr Libreoffice Shoot # @ffes yar it Feaa 3¢ A
feU ITT T T 3IUAIT = T 394 Presentation & &9 3¢ &1 Insert & Thd @l

\/:ﬁ?cr\aﬂ A Insert>Media-> Gallary
/MWHWW%SeIect |
v frr fFeaasne « ee click Y 3R insert W click #Y
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Slides

=
- - BIIEts éy
— Upciss prime B
N ®
’ \ o
=
B A W 2

-4 |'/'. /

- 4

P o
¥ 8= New )

Inserting Other Objects

Slide & 3k &de insert aX Thd g O &H TASS &I 3R TOT dallel ToIT STAATT
g g &H libreoffice application garT §<TT 1w P IR & AT dfeah FS Iy ITherel
TColiheled 3 insert & ¥ohd &l

$HC Al N W e Y 30 91 AT W ¢ 38 a1 3ifsar ar Aifsar Afzar de sitsaere
3Tfe W Feer Hl|

v Insert Menu Bar wX Click &Y 3&& @€ Image>Audio or Video / Media /Chart /
Object 31fg W el Hl

v Insert Image dialog box & X fg@rs &am|

v’ File, image, picture @ Select &Y 3K open Fea W Fed F

Resizing and Scaling an Object

Image @ Resize it & 0T AT W For A IR NMas a9 7 @ 6 W v W
MS Office presentations, Fr aig & 3& 81 Farh 3iX 39T +X Image @' Resize FT Tdhd gl

Upciss prime




Creating & Using Master Slide

A o7 Librreoffice Impress @7 Teh a9y yehR i AATAT & St fob 3T9ehT Yoierrel & Fellss

3R FAIS5H AT AT STedl F ANSHS Fal &I IFAT &adr § Teh AN Fll38 aseel 3R
33 & fow caee BT Tege 3R Tt Tomssa & v dean3s Bamsa HulRa #dr

g S 39 AR TASS FT 39ANT d &1

Steps to Create Master Slide

View menu T ST 3T% s Master Slide &I deiee & T& Slide Design Dialog T @

fe@rs gam Master Slide & s Slide @ Select &Y

EREER
File Edit View Insert Format Slide SlideShow Tools Window Help &
B-E2-B- 0 .. g BHER-E TS E-ECihE F 2 = =
&l L-B-\NOOI—-¥-L-C-O-=-B-J-%7-B-13 o Ak
Slides 52 i Master Slides o=
1 I Used in This Presentation o E
. . . L= 7%
Click to edit the title text format flnmwrd e
ik O]
* Click to edit the outline text format ") Auaabe for Use &
- Second Outline Level - | = "@ =
« Third Outline Level =5 ) =
|
- Fourth Outline Level = =
* Fifth Outline Level - , - I - H
* Sixth Outline Level o a
» Seventh Outline Level = ==
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Adding Movie & Sound
Movies 3iIX sound g & fow ®Y

v 38 TaeE W 1 5@ 317 Video Clip Siear argd &
v' Go To = Insert Menu = Audio/video

v/ 38 Folder #r Select &% fw# ag File ¥ @y 317 @ § o@mem 3R A Open W
Click &Y

= =
« « 4 B > ThisPC » Desktop w Search Desktop pe
Organize - Mew folder = - ™ @
group 2 &

M3 RS . m . .
| | Application Link ’Pi: - e ' m I

@ Onelrive - Persc

all data bootstrap use cee local notes cce notes design
[ This PC wehsite
J 30 Objects

[ Desktop \\l \\I

|| Documents £ g

4 Downloads T N

b Musi demoll HOME TAB home tab, auto JKE

Hsie SHORT AMD sum, series, clear
&= Pictures FILTER
HFH vt 8 8

File name: ~ | | All audio and video files (*.aac®

[JLink Open Cancel

Adding Headers, Footers and Notes

Header, Footer, Notes Add &y & ¥Y

vV gg doieus AU #Y fow o R s gst oar BeX d Siiser WEd §  Insert
Menu->Header and Footer 9¥ U]

v 3 =@t @ Tab @ Slide 3R Notes 3R Handouts 1@t 39 319+ 3maedsar &
3TER ¢aee 3R ST 3¢ W FH &

v 9% TES SrgereT S 3 g@em foad date and time check box saeer § afde
39 fheres a1 afkueer 3icersT W click &Y 3R 3m9ar date format 3R $TWT dT X dha
& footer check box = sade #¥at & oI 3T footer & sAC Y T Tohd &1

v’ Header, Footer 3R notes /et & a1g 3als aF st W Farsh

48
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7. Ctrl+M New Slide

8. Shift+F3 Duplicate Object

9. Ctrl+Q Exit LibreOffice

10. Ctrl+X Cut

11. Ctrl+C Copy

12. Ctrl+V Paste

13. Ctrl+Z Undo

14, Ctrl+Y Redo

15. Ctrl+H Find & Replace
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It takes a lot of hard work to make notes, so if you can pay some fee 50,
100, 200 rupees which you think is reasonable, if you are able to Thank
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+91 6392067607
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